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1. Introduction                                                
Welcome to MakeUseOf’s “Guide to KDE: The Other Linux Desktop.” This guide is meant to introduce the so-called 
“power users” of computers with an introduction to KDE, including the option (and freedom) that it provides. If you fall 
into one of the following categories, this guide is for you:

•	 You’re a Windows user, but are turned off by the new Windows 8 look and Start Screen. You’re 
looking for an OS that works kind of like Windows 7, but even better.

•	 You’re a new Linux user, and have been trying out Ubuntu. But Unity, the Dash, Scopes, and 
Lenses just aren’t your thing. Where’s the “Start” button?

•	 You’re an intermediate Linux user, and now you have a taste for customization. So you’re look-
ing for a way to configure your own, great-looking desktop, with lots of shiny gadgets every-
where.

•	 You’re an old-school Linux user who’s just now (begrudgingly) installing X, and you need to pick 
a desktop. You’d rather just use emacs for everything, but you admit sometimes colors are nice.

In this guide we’ll provide an overview of the KDE desktop environment, let you know how to get it and install it, 
introduce the various pieces of the base system (i.e. the desktop), and finally describe how to perform some common 
tasks with the applications that come with it.

But first, a little background on KDE.

1.1 What is KDE?
KDE, or more correctly “the KDE Software Collection,” is a project founded in 1996 by Matthias Ettrich to provide a 
full-featured desktop environment for free software operating systems (including Linux). At the time, there were a num-
ber of programs (referred to as “window managers”) providing a graphical user interface (GUI) for these OSes, but 
none in particular were leading the pack.

KDE was an attempt to recreate the functionality of packages such as the Common Desktop Environment (CDE), 
which was the default GUI for many commercial/proprietary versions of Unix. But it also sought to standardize the 
pieces (widgets) that make up the applications. For example, if a user opened an application at the time to send an e-
mail, that program might have to open libraries of widgets to draw the windows, provide graphics for the buttons, edit 
the text, print the e-mail, and send the e-mail, all from different projects and with the inconsistencies that entails. KDE 
was meant to create a desktop environment with some consistency, targeted at the end user.

So at this point, we’ve used the term “desktop environment” a number of times. What the heck does that mean?

1.2 What is a “Desktop Environment”?
On a Linux system (as well as other free, Unix-like software systems), there’s a “stack” of software that ultimately 
displays a GUI for the user:
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Note: image courtesy Wikimedia Commons

•	 At the lowest level, the Linux kernel and its drivers talk to the computer’s display, and tell it when 
to light up pixels, and how.

•	 The X-Window System (or X11, or simply X) coordinates the lighting of these pixels to draw 
windows. The “background” is referred to as the “root window,” and other programs open in their 
own windows on top of it.

•	 A window manager arranges all these “X-windows,” and allows for things such as clicking on the 
title bar of one program to “raise” it above another.

•	 Toolkits provide commonly used pieces to programs, such as menu bars, buttons, file dialogs, 
and the “frames” for the window manager to use to decorate.

•	 Lastly, a desktop environment will provide a window manager (or work with an existing one), 
use a common toolkit across its applications, and provide countless other useful elements, from 
basic tools such as application menus, lists of programs currently running, and a way to manage 
files to advanced ones such as a full-featured “control center”-style application.

Desktop environments are a great example on the “standing on the shoulders of giants” philosophy that makes the 
free software community so great. So how does KDE fit into that community?

Here’s a comparison of some of the main desktop environments for Linux, if you’re curious.

1.3 KDE in the Linux Community
KDE serves several important roles in the Linux community:
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•	 It is one of the most successful free software projects around, and serves as proof of the ben-
efits of free software.

•	 It is the default desktop environment for a number of Linux distributions, giving them a powerful, 
modern UI.

•	 It supplies the community with lots of free applications – from games, to music players, to office 
programs. Even if you don’t use KDE as your desktop environment, you’re still free (encouraged, 
even!) to take advantage of its apps.

•	 It provides developers who aren’t formal members of the project with a great head start for de-
veloping their applications. They don’t need to worry about drawing their own buttons or coding 
their own file dialogs... the KDE libraries provide all of this.

So now that you know what KDE is all about, how do you go about getting it? Let’s take a look at ways you can take 
this desktop for a test drive.
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2. Getting the KDE Software Compilation           
There are a number of ways to get KDE and its components. It’s easiest to try out on Linux as follows:

•	 Use a distribution that provides KDE as its default desktop environment

•	 Install KDE in your existing Linux distribution, as an alternative to your existing desktop environ-
ment

KDE’s cross-platform Qt toolkit also works on other, non-Unix platforms, and it’s possible for advanced users to get 
these applications by the following methods:

The KDE project provides an installer to add KDE applications to Windows

You can also install these applications on Mac OS X via the macports, fink, or Homebrew projects as de-
scribed here (between them, macports tends to have the more updated version)

Neither of these methods are exactly easy to use or stable, so keep that in mind: the easiest way to try KDE is within 
Linux. So let’s explore how to get a KDE environment on Linux you can explore.

2.1 Pre-Installed KDE Distributions
There are a number of distributions that provide and integrate KDE out of the box, including the following (all of which 
are part of MakeUseOf’s list of Best Linux Distributions:

•	 Kubuntu

•	 Fedora

•	 Linux Mint

•	 OpenSuSE

You can normally test out these distributions by creating a Live USB drive. For instructions on how to create and boot 
these, you can refer to these MakeUseOf articles describing the process:

For Windows, using Linux Live USB Creator

For, Mac OS X using these instructions to boot a Linux live USB on a Mac

For Linux, using Live USB Install

While making a Live CD is also an option, the size of the image files have begun to exceed what CDs can typically 
hold. Using a USB drive is your safest bet, and more portable. A final alternative is to create a virtual machine with one 
of the KDE-based distributions. If you’re new to virtual machines, read about how MakeUseOf explains and highlights 
two virtual machine programs that run on Linux.

But which distribution to select? Let’s take a look at a few.

2.1.1 Kubuntu
Kubuntu combines the extensive Ubuntu repositories with an up-to-date KDE desktop environment. If you’re using 
Ubuntu and want an Ubuntu-based option, but don’t want to install it on your main system just yet, getting a Kubuntu 
Live CD/USB is the easiest way to try it out. You can head over to the Kubuntu website to see what it’s all about.

•	 Pros: Uses the common Ubuntu repositories. Provides an almost-vanilla version of KDE (good 
for avid customizers).

Caveats: No longer officially supported by Canonical, the corporate developer of Ubuntu (but rather by Blue Systems, 
who also supports the KDE version of Linux Mint). Provides an almost-vanilla version of KDE (for new users, it may 
seem a little bland).
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Note: As the author is an avid Kubuntu user, the instructions in this guide will be for that distribution by default.

2.1.2 Fedora
Fedora is the community-driven distribution that forms the foundation of Red Hat Enterprise Linux. The project aims 
to make rapid, regular releases, meaning you can always look forward to the best features. Although Ubuntu and its 
relatives are arguably more popular than Fedora/Red Hat (at least for consumer users), its RPM package format is still 
well-supported, meaning it’s rare to run into a problem finding a native package for third-party applications (i.e. those 
that aren’t distributed by Fedora itself). Visit the Fedora Project to pick up a copy.

•	 Pros: Widespread package support. “Rawhide” distribution with rolling updates.

•	 Caveats: GNOME is the default Fedora desktop (KDE is installable or available as a “spin” or 
variant of the standard distribution).

2.1.3 Linux Mint
Mint has become one of the most popular distributions; according to DistroWatch, it is the most popular (as measured 
by hits per day on its site), while the Mint site claims it is the fourth-most popular desktop operating system (behind 
Windows, Mac OS, and Ubuntu). Derived from an Ubuntu base, it adds additional polish, and is targeted as being the 
easy-to-use Linux version for novice and advanced users alike. This page is the latest Mint KDE version at the time of 
this writing (Linux Mint 15 “Olivia”).

•	 Pros: Adds polish to an already polished Ubuntu base.

•	 Caveats: Typically releases later than Ubuntu (since Mint builds on its packages). KDE is a non-
default desktop that releases even later than the standard Mint versions.

2.1.4 OpenSuSE
OpenSuSE is the non-commercial variant of the long-standing SuSE Linux distribution, designed for community use. It 
uses a custom KDE environment to create a very branded and consistent feel. The features from this version eventu-
ally make their way into the commercial distribution (SuSE Enterprise Linux), but OpenSuSE follows a more frequent 
release cycle similar to others such as Ubuntu and Fedora (described below). You can easily grab the KDE version of 
the live CD.

•	 Pros: Up-to-date and optimized KDE packages. Custom “YaST” system settings application.

•	 Caveats: Smaller package selection. Less regular release schedule. Custom package manager 
(Zypper).

2.1.5 Honorable Mentions
Distrowatch lists over 100 distributions that offer KDE (some as default, some as an option). Some other popular alter-
natives are:

Debian GNU/Linux: One of the longest-lived distributions, it forms the foundation of Ubuntu. You can install KDE once 
the base installation is installed.

Mageia: A fork of one of the oldest KDE-focused distributions (Mandriva).

PC-BSD: Based on FreeBSD (a Unix-like OS similar to Linux), this aims to be the BSD for the non-technical user.

All told, you’ll have no problems if you select any of the above options to try out KDE. If you’re wondering what makes 
one distribution better/worse/different compared to others, this MakeUseOf article about the difference between Linux 
distros can help explain.

2.2 Installing KDE in Linux
If you’re already using Linux and have hard drive space to burn, you can easily install the KDE desktop right now. 
There’s no risk in doing so – it won’t “take over” your desktop – it will simply appear as an option the next time you log 
in (we’ll cover how this appears in your display manager in a later section).
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You can often find a metapackage, or a package that will install other packages, for KDE using your preferred software 
manager. Look for one that says “KDE Desktop,” or simply “KDE.” The corresponding packages and their command-
line install commands are listed below for Ubuntu, Fedora, Linux Mint, and OpenSuSE:

•	 Distribution:Package Name /Command-line Install

•	 Ubuntu:kubuntu-desktop /sudo tasksel install kubuntu-desktop

•	 Fedora:”KDE Software Compilation” /yum groupinstall “KDE Software Compilation”

•	 Linux Mint:mint-meta-kde /sudo apt-get install mint-meta-kde

•	 OpenSuSE:kde4, kde4_basis /zypper install -t pattern kde4 kde4_basis

These quick commands will install the following items for you:

•	 KDE base system, including libraries and the Qt toolkit

•	 The KDE Plasma Desktop shell, including basic items such as applications menu, system tray, 
and desktop

•	 Many base applications, such as a file manager, web browser, utilities (calculator, etc.), and 
system configuration tools

We’ll explore all these parts of the system one at a time in the next section.
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3. Using KDE                                                   

3.1 Logging In
The first step to using KDE once it’s installed is logging out of your current desktop session. Once you do so, you’ll 
be directed to the login manager (often called the “display manager”) for the system. Depending on your system, you 
might have the KDE greeter (or theme) installed.

If not, you can still get to KDE with your existing display manager. This is LightDM on an Ubuntu system, with the 
default Unity theme.
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If you had no other desktops previously, you may not have had the ability to select a “session,” but you should now. 
How it appears will depend on your login manager and distribution, but there should be a button or drop-down that al-
lows you to select a “KDE”-titled session. On a default Ubuntu installation it’s a little white Ubuntu logo.

Click the logo, and select KDE from the list.
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You can tell you’ll be directed to KDE by the little white logo, which is now updated to the KDE logo.

Log in with your username and password, and you’re off and running. The first thing you’ll see is the progress window 
as the components of the desktop are loading.

http://www.makeuseof.com
http://two-mutts.com/
http://www.makeuseof.com
https://www.facebook.com/sharer/sharer.php?u=http://www.makeuseof.com/pages/download
https://plusone.google.com/_/+1/confirm?hl=en&url=http://www.makeuseof.com/pages/download
http://www.linkedin.com/shareArticle?mini=true&url=http://www.makeuseof.com/pages/download
http://twitter.com/home/?status=I'm reading a free manual from MakeUseOf; you should too! http://www.makeuseof.com/pages/download


KDE: THE OTHER LINUX DESKTOP

14HTTP://MAKEUSEOF.COM
AARON PETERS, HTTP://WWW.TWO-MUTTS.COM share:

Once that’s complete, you’ll see a shiny new desktop. Let’s take a look at some of the parts of the desktop as it comes 
out-of-the-box in the next section.

3.2 An Overview of the KDE Desktop
3.2.1 The Desktop

http://www.makeuseof.com
http://two-mutts.com/
http://www.makeuseof.com
https://www.facebook.com/sharer/sharer.php?u=http://www.makeuseof.com/pages/download
https://plusone.google.com/_/+1/confirm?hl=en&url=http://www.makeuseof.com/pages/download
http://www.linkedin.com/shareArticle?mini=true&url=http://www.makeuseof.com/pages/download
http://twitter.com/home/?status=I'm reading a free manual from MakeUseOf; you should too! http://www.makeuseof.com/pages/download


KDE: THE OTHER LINUX DESKTOP

15HTTP://MAKEUSEOF.COM
AARON PETERS, HTTP://WWW.TWO-MUTTS.COM share:

If you’re familiar with the “Windows”-style of desktop layouts, things should look fairly familiar. Most of the screen is 
the desktop background, where you can place things (including, but not limited to, a background, links to files, and 
other fun widgets). It operates a little differently than Windows or Mac desktops, however, in that the default desktop 
doesn’t hold those things directly (at least not by default). Instead, you can place things on the desktop that will hold 
all those things (this is typically a Folder View Widget). Out of the box the Kubuntu desktop contains one of these wid-
gets, which reads “This folder is empty.” We’ll explain how to get things to show up here a little later.

3.2.2 The Panel
There’s also a Panel at the bottom of the screen with controls, and a desktop background. Out of the box most 
KDE desktops will start you out with the Panel elements in the sections below.

3.2.3 The “K” Menu
The “K” menu at the far left of the Panel is much like the “Start” menu in that other OS. It allows you to browse through 
all your installed GUI applications. But where other systems will often group these by manufacturer or application, 
KDE does contain some categories to allow you to organize things a bit more:

1.	 Development

2.	 Education

3.	 Games

4.	 Graphics

5.	 Internet

6.	 Multimedia

7.	 Office

8.	 Settings

9.	 System

10.	Utilities

11.	 Lost & Found
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We’ll visit some of the programs within each of these groups in a later section, but know in the meantime you can use 
the “K” menu to get to them. It’s also useful to note that this menu doesn’t contain icons for command-line applica-
tions, but if you find yourself using these you can create new menu items for that (we’ll cover that later as well).

It also contains tabs for maintaining a “Favorites” list of your most frequently-used applications, links to key settings 
and locations on your computer, a list of recently-used documents or files, and the buttons for you to log out, reboot, or 
power off your computer.

3.2.4 Activities
Many users are familiar with the concept of “virtual desktops,” or multiple copies of the computer desktop that exist in 
parallel. This allows you to, for example, have some office document windows open on one screen while also having 
your mail and instant messenger open on another, all “active” at the same time without the need to switch (i.e. “Alt-
Tab” or “Command-Tab”) between them. Activities are similar, but more powerful: you can choose to have different 
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backgrounds/widgets on the desktop between activities, and configure certain applications only to open within select-
ed Activities. This feature can be as powerful or simple as you choose to make it. We’ll cover Activities in more depth 
later.

3.2.5 Task Manager
The Task Manager is a list of currently running applications, just like the one in Windows, and it functions in a similar 
way:

•	 The Task Manager shows the icon and title of each application currently open.

•	 The “active” application (i.e. the one you’re using) is highlighted.

•	 Clicking on an application other than the current one will make the selected one “active.”

•	 Right clicking on an application gives you options to maximize it, minimize it, or close it, among 
others.

3.2.6 Widgets
KDE comes with all manner of widgets, most of which you can place on a Panel or your desktop. The “Show Desk-
top” widget pictured here does exactly what you’d expect... when clicked, it lowers all windows so you can get at your 
desktop links or files, and raises everything to where it was when clicked again.
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Another example of a Widget is a Quick Launcher, or buttons on the Panel that will launch your favorite applications. 
In the figure below a Quick Launcher is set up for Dolphin, KDE’s file manager.

3.2.7 System Tray
The System Tray is also similar to the one you’d find in Windows or Mac OS. Programs that run in the background, 
ones that only require quick input/selections, or ones that are more system-related will show as icons here. Left- or 
right-clicking on these will give you the options to work with them (which for some include opening in a regular win-
dow). Some of the important ones pictured here are as follows:

1.	 The first icon will appear when updates to your software are available. It will launch the Muon 
Updater program (we’ll cover this later), which allows you to download and install all updated 
software automatically.

2.	 In addition to icons for the clipboard (indicated by scissors) and volume (indicated by the speak-
er), there’s also one to access all your removable media. This currently shows that the Virtual 
Box CD for Guest Extensions is in the computer’s drive. Other media like USB drives will also 
show up here.

3.	 The KDE Network Manager is also in the System Tray, and lets you configure different network-
ing set-ups (like wireless passwords) for different locations. You can then switch between them 
with a couple of clicks.
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Let’s get into customizing some of these elements, so you’ll feel a little more at home.

3.3 Customizing Your KDE Environment
3.3.1 Desktop
The first thing you may want to change is your desktop background image. You can do so easily by right clicking on 
the desktop background, and selecting the “Default Desktop Settings” option in the menu.

This will display a dialog allowing you to select a pre-installed wallpaper, download additional wallpaper images from 
the KDE project (using the “Get New Wallpapers” button), or use a file on your computer by clicking the “Open” button. 
If you select an image of the same dimensions as your screen you’re all set.
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Otherwise, you can set its placement on the desktop using the following drop-down options in the “Positioning” dialog 
item:

•	 Scaled & Cropped: This option will fill the entire background with the image by scaling it up or 
down so that the shortest side fits the full width/height, then cropping from the top and bottom or 
left and right of the image to make it fit the other dimension. For example, if you select a 700px 
by 500px image for an 800px by 600px screen, this option would expand the image to 840px by 
600px, then crop the 20px from the top and bottom to make it fit the screen.

•	 Scaled: This option will fill the entire background with the image by scaling the height and width 
up or down to accommodate both dimensions. This will make sure your entire image is on the 
screen, but may result in some distortion if the both dimensions aren’t scaled the same amount 
(in the example above, the 700px by 500px image would end up looking “stretched” horizontally, 
because the width needed to be increased more proportionally than the height to fill the screen).

•	 Scaled, keep proportions: This option will ensure the entire image is on screen, but may leave 
some excess space either at the top and bottom, or left and right, if the image isn’t the same 
dimensions as the screen. This excess space is just filled with a plain border color (black by 
default, but you can change this using the “Color” button directly below the “Positioning” item).

•	 Centered: As it suggests, this option will center the image on the screen. If the image is smaller 
than the screen, it will display border space on all sides as needed. If the image is larger than 
the screen, it will place the center of the image at the center of the screen, so there will be por-
tions of the image that are not visible on-screen.

•	 Tiled: This option will place the image at native size at the top-right corner of the screen, and 
repeat it in columns and rows across the screen. Note that if the image is larger than the screen, 
it will just display as much of the image as the screen size allows, starting from the top-right 
corner.

•	 Center Tiled: Lastly, this option will place the image directly in the center of the screen, and 
repeat it in columns and rows around it. This ensures at least one view of the image is fully dis-
played in the middle of the screen, unless it’s larger than the screen size. In this case, it will just 
appear to be centered.

This was a lot of explanation, but the easiest way to set this up is just to try each option in turn, click the “Apply” but-
ton, and see which ones you like.
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3.3.2 Panel
Next, you may not like the location of the Panel at the bottom of the screen. First, click on the icon at the far right-hand 
side of the Panel, which opens up Panel Tool Box.
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This contains a number of options to customize panels, one of which is the “Screen Edge” control in the middle of the 
second row. By clicking and dragging on this control, you can place the Panel on any edge of the screen you like.

The Panel Tool Box also contains some other useful controls, including the following:

•	 The first row of the Tool Box allows you to control the size. The top or left side will have a slider 
control controlling where the panel begins. The left or bottom of the panel has two controls, one 
of which will set the minimum width of the Panel, one of which will set a maximum width. As you 
move these around, you’ll see the Panel size change in real-time.

•	 The second row contains the aforementioned “Screen Edge” control, in addition to a few others. 
These include a “Height” control (which controls the height, or thickness, of the Panel), an “Add 
Widgets” control (more on this later), an “Add Spacer” option (this will add empty space between 
two Panel widgets so that, for example, the “K” Menu always appears at the far left of the Panel), 
and a “More Settings” button, which contains options for aligning the Panel on the edge of the 
screen, auto-hiding it when not in use, removing it, or making it maximum width.

Once you’re happy with the Panel’s placement, you might have noticed one last option in the “More Settings” menu: 
“Lock Widgets.” Since you’re able to set the placement of the Panel (and Widgets, as you’ll see shortly) via drag-and-
drop, KDE provides a way to make sure you don’t accidentally move (or worse, remove) any of these desktop tools 
with a stray mouse gesture. When you select “Lock Widgets,” you won’t be able to move things again until you select 
“Unlock Widgets” from the right-click menu of the Panel, desktop background, or most other Widgets in the system. 
You do have the ability to configure these items with a right-click as well (the option is usually something like “Task 
Manager Settings”), but you can’t reposition them unless you “Unlock Widgets.”
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Lastly, let’s do some re-arranging of items on the Panel. If you need to, go ahead and “Unlock Widgets” so you can 
move things around. Hit the “Panel Tool Box” button, then mouse over an existing item, such as the clock at the far 
right. A four-arrow icon will appear over the item, indicating you can drag it to a different place on the Panel. Drag it all 
the way to the left (past the “K” menu), then release. Presto! You can use this process to order things on the Panel to 
your liking.

You can also remove any items from the Panel by right clicking on it, and selecting the “Remove [Widget Name]” op-
tion from the menu that appears.
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Lastly, unlike some environments, you aren’t limited to having just one panel. Minimize all your windows until you’re at 
the desktop background again (or use your Show Desktop button on the Panel, if you didn’t remove it), then right-click. 
There’s an option titled “Add Panel,” which has two sub-items: “Default Panel” and “Empty Panel.” The “Default Panel” 
will create a new version of a Panel containing items such as the “K” Menu, Task Manager, System Tray, and clock. 
But you should already have one of these, so select “Empty Panel.” Now you have a new space to put some cool stuff.

But how do you get that cool stuff onto the Panel? Now that you’ve done some basic customization, start adding some 
Plasmoid Widgets.

3.4 Adding Widgets to Your Desktop
Widgets is a generic term that includes a number of things on your desktop, including the “K” Menu, the Task Man-
ager, and more. Plasmoids are the KDE-native format for widgets, although KDE does also support widgets from other 
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systems, including web-based widgets (written in HTML and Javascript), SuperKaramba widgets (a widget system 
included in the 3.x version of KDE), and Apple widgets.

So as it stands, you already have a number of Widgets. Most Widgets have a number of options you can configure, 
which are accessible by either right-clicking on the widget (and selecting the option like [Widget Name] Settings. For 
example, by selecting the “Digital Clock Settings,” you can change settings such as the color and font used, which 
timezone to use, and whether it should also display the date.

Let’s start by adding a new widget to the desktop, then we’ll configure it. Minimize all your open windows, then right-
click on the desktop background. Select the “Add Widget” option (note that Widgets will need to be Unlocked for this to 
appear).

You’ll be presented with a scrolling, “filmstrip-style” dialog showing all available widgets.
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There are a number of ways to find your desired widget in this dialog:

•	 You can browse the entire selection, using the scroll bar at the bottom, or the scroll wheel on 
your mouse.

•	 You can type a keyword into the “Enter search term...” box to show widgets that match.

•	 You can use the “Categories” list to filter to show widgets from a selected category.

There are a lot of items on this list, some of which you’ll recognize (such as the “System Tray,” which is included in the 
Default Panel created when you first logged in), the rest of which range from quite useful (such as the “Folder View” 
widget) to not-so-useful, but still fun (e.g. there’s a widget that displays a pair of eyes, the only job of which is to follow 
the cursor around the screen). We won’t describe all these here – you can hover over a Widget to get a short descrip-
tion – but like most things, the easiest way to see if you like it or not is to go ahead and select it. Let’s do just that with 
two of the widgets the author uses most: the “Folder View” and “Picture Frame” widgets.

3.4.1 Add the Widget to the Desktop
First, bring up that “filmstrip” dialog as described above. In the search box, enter “folder.” You’ll see the list reduce to 
(depending on your distribution) just a few items, one of which is “Folder View.”
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To place this on the desktop, all you need to do is click-and-drag the item to the background.

When you release the mouse button, a new Widget will pop into view. Open that dialog again, and this time search for 
“picture.” Grab the “Picture Frame” widget, and drag that onto your desktop as well.

3.4.2 Configuring Widgets
Now that you’ve got these new widgets, let’s change them a little. For example, let’s set the “Folder View” Widget to 
display the contents of the “Desktop” folder instead of the entire home directory. You can get to the configuration for 
the Widget by either right-clicking on it, or by selecting the wrench icon on the “handle” that appears when you mouse 
over the widget (provided your Widgets are still “Unlocked”).

The first tab on the settings dialog is what we’re looking for. There’s a radio button allowing you to set the Widget to 
display the Desktop folder, but you can also select from among Places (which includes pre-determined file paths such 
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as the home directory, removable media, and network locations), or select your own folder path to display in the wid-
get. You can also see other tabs to modify how the Widget displays icons and whether it will filter for a particular type 
of files. Once you’re finished, click “OK” to close the dialog.

Now we want to configure the Picture Frame, but also move it so it doesn’t overlap with the Folder View. Click-and-
drag on the Widget’s handle to move it to the lower-right corner.

Better, but now that it’s moved, we can make it a lot bigger to fill space. Click-and-drag on the top-most rectangular 
icon on the handle to resize the Widget.
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Now, let’s set up the Picture Frame by selecting the wrench icon. The Picture Frame can either be set up to show a 
single image, a slideshow that will periodically rotate through all the picture files in a given folder, or a “picture of the 
day” from external sources such as Flickr or National Geographic. If you select the “Image” option and click the folder 
button, you’ll be prompted to select a single image file to display. If you select the “Slideshow” option, you can add 
multiple folders (the images from all of which will be displayed in the slideshow), select whether to show the images in 
random order, and configure how often to update the images.

Once you click “OK,” the first image should appear in the frame, and it will display a new image based on the duration 
you chose.
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You can configure other desktop widgets in the same fashion: add one to the desktop, move it, resize it, and then con-
figure its Settings. But the desktop isn’t the only place for Widgets... the Panel can hold them too!

3.4.3 Adding Widgets to Panels
Some Widgets can be added to Panels as well as the Desktop. To add one, right-click on the Panel instead of the 
desktop background. You may get some options for an already-present Widget, but there will be a menu item titled 
“Panel Options,” within which you’ll find the “Add Widgets” item.

This calls up a familiar dialog... this time, instead of dragging your preferred Widget onto the Desktop, pull it over the 
Panel. It’s sometimes tricky to get it to a place where it’s not in the center of an existing Widget—you should see the 
“shadow” of an empty space open up, at which point you can drop the new Widget there.

In this case, we’re placing the same “Folder View” Widget on the Panel that we did on the desktop (configured to 
display the contents of the “Desktop” folder as we did above). When dropped on the Panel, however, the Folder View 
displays as a button with the folder’s icon. When you click this button, a pop-up list of all the folder’s files and sub-
folders appears. So even though the way you work with Widgets on the desktop and on the Panel may differ slightly, 
their basic functionality is the same.

Here are a couple of noteworthy Panel Widgets that you may want to explore:

•	 Menubar: In the style of the Macintosh, this moves the main menu (normally “File,” “Edit,” etc.) 
for applications into the panel, giving you a little more room in the program’s window.

•	 (Icon Only) Task Manager: You can add a task manager to a Panel as well. We’ve seen the 
“Windows-style” task manager that displays the program’s icon and title, but there is also an 
alternate “Icon Only Task Manager,” that displays a larger icon (more like Mac OS X’s Dock or 
the Dash in Unity). Also, you have the ability to modify what programs are displayed, so you may 
want to set up one Task Manager for only the screen you’re in, and one that displays all the open 
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programs regardless of what screen they’re on (we’ll discuss more about what these “screens” 
mean when we review Activities).

•	 There are three different “K” Menu-style Widgets that come with KDE out of the box. The “Ap-
plication Launcher” is the tabbed “K” Menu we saw earlier in this guide. There’s a simpler option, 
called “Application Launcher Menu,” which displays all the system’s programs similar to the 
menu from Windows 95. There’s also a more modern option, titled “Homerun Launcher,” which 
allows for display of all applications alphabetically and searching by name, similar to how the 
Unity Dash operates.
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Now you have your environment just the way you want it... for now. But what if this set-up doesn’t work for some of the 
other things you do? What if you like to have lots of pictures and interactive do-dads around for your downtime, but 
when it’s time to work you focus on lists of files and folders? KDE can support you with different environments for the 
different stuff you do on your computer—welcome to KDE Activities!

3.5 Introduction to Activities
KDE’s Activities model was created as an alternative to “virtual desktops,” which allow you to have different sets of 
programs open in different “virtual” screens so they won’t interfere with one another. A couple of uses for this include 
the following:

•	 Keeping all work-related items on one screen, and all personal-related on another

•	 Keeping multiple windows of communications programs such as e-mail and IM open for multi-
tasking on one screen, but only one full-screen application open on another for when you want 
to buckle down

Note: MakeUseOf has also covered Windows virtual desktop solutions, Mac workspaces and their use, but these strat-
egies will also apply to virtual desktops and Activities on Linux.

While KDE supports virtual desktops as well, Activities are meant to be an “upgrade” to this model. Compared to vir-
tual desktops, Activities have the following advantages:

•	 Activities can have a unique desktop background

•	 Activities can have a unique set of Widgets on the desktop

•	 Programs can be configured to start in particular Activities, so if you have a “Work” Activity, you 
may want the LibreOffice applications to start there by default

The application of Activities will depend a great deal on how you go about your daily computing, but let’s suppose that 
you spend your time in three primary “buckets”:
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•	 You spend time browsing Facebook/Google+/Twitter while responding to instant messages and 
sending e-mail.

•	 You are also a writer, diligently working on a new MUO Guide, including writing the text and tak-
ing screenshots.

•	 Lastly, you’re an aspiring developer, and are trying to teach yourself some coding using the 
Eclipse IDE

In order to keep things organized, you might set up three Activites as follows:

•	 “Main”: This is your “hanging out” Activity, and is decorated by a large picture of your pets in the 
background. You put Widgets on the desktop including an additional Picture Frame (for photos 
of family and friends), weather (for an at-a-glance forecast), and a system monitor (which keeps 
track of your CPU usage, RAM usage, and temperature). You set the instant messenger pro-
gram (Kopete, we’ll cover this later) to always open in this Activity, as well as your e-mail pro-
gram (Kontact). Lastly, you place a Facebook Widget that displays a view of Facebook directly 
on your desktop, and two Web Browser Widgets on the desktop with so you can have the other 
social media sites open at all times.

•	 “Work”: This is for work, and contains a Folder View Widget for each of your current projects on 
the desktop, as well as a single Quick Launch Widget with all your office-type programs.

•	 “Development”: This contains more Folder View Widgets (showing the contents of coding project 
folders), as well as a Quick Launch Widget with an Eclipse Launcher. You’ve also set up cus-
tom configurations for Kate (one of the text editors for KDE) and Konsole (a terminal emulator) 
that help with your coding activities, and you’ve linked each of these to a Kate Session Widget 
and Konsole Session Widget, respectively. Finally, you’ve set up Eclipse, Kate, and Konsole 
to always start in this Activity, along with some other development programs such as KDEsvn 
(a source control program) and Kompare (a program that compares two files to find the differ-
ences).

With these ideas fresh in your mind, here’s how to create a new Activity. First, click on the desktop background, and 
select the “Activities” option; you can also click on the “Workspace” menu at the top-right corner of the screen (unless 
you have a full-width Panel at the top, in which case it’s a smaller tab a few inches down the right-hand side of the 
screen) and select the same option.
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This displays the Activities bar at the bottom of the screen, displaying all Activities currently configured for your sys-
tem. Depending on your distribution, you might have a couple of extra ones already set up (Kubuntu will only create a 
“Desktop” activity by default).

Clicking the “Create Activity” button gives you the option to set up a “Empty Desktop” activity like the default one (i.e. 
with a desktop background for placing Widgets), to duplicate your current Activity (in order to make minor changes, for 
example), or one of the available Templates, which include the following types:

•	 Desktop Icons: This is a more traditional “desktop” metaphor where you have the ability to place 
things directly on the desktop (as opposed to using a Folder View Widget).

•	 Folder: Similar to the above, this operates even more like the desktop is Windows XP, where 
icons are placed on the desktop with the option to line them up and sort them automatically. 
Note that you can still add other Widgets to this template, as well as the Desktop Icons template 
above.

•	 Homerun: This template creates a desktop background identical to the menus you see when 
clicking on the Homerun Launcher button in a Panel.
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•	 Newspaper Layout: This template allows you to add widgets in “blocks,” not unlike the new 
“Metro” interface of Windows 8. It’s useful for putting Widgets that show a lot of different informa-
tion from different sources into a compact, at-a-glance view.

•	 Photos Activity: This template pre-creates two Widgets for you, one Folder View that’s pointed 
at your home directory’s “Pictures” folder, and another a Picture Frame Widget set to show a 
Slideshow of all the images in that directory and its sub-folders.

•	 Search and Launch: This template is focused on finding programs, and is comprised of two 
sections. The top of the screen contains links to some of your favorite applications and a search 
box. The bottom contains icons allowing you to navigate the applications on your system. These 
will look familiar, as they’re the same categories as those shown in the “K” Menu and Homerun 
widgets.

Once you select an option (“Empty Desktop,” duplicate the current Activity, or use a Template), your new Activity will 
appear, ready for you to load it up with Widgets. There are two important things to note about Activities, however:

•	 Firstly, Panels are currently shared across all Activites. That means if you make a change to a 
Panel in one Activity, it will appear that way for all Activities.

•	 On the other hand, you can still use virtual desktops with Activities. But the settings for an Activ-
ity (desktop background, Widgets, etc.) will be common across all the virtual desktops. Only the 
set of open programs will differ as you go from one virtual desktop to another.

There are many other ways in which you can customize your KDE environment, most of which are performed through 
the System Settings application. We’ll cover this in the next section, along with a number of the other programs that 
come with the KDE Software Collection.
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4. KDE Base Applications                                     
While almost all of the programs in the below sections are part of the KDE SC, we’ll be covering them in two separate 
sections: one section describing the applications to perform the most basic computing tasks, and one section provid-
ing an overview of some of the programs that are part of the SC’s main categories.

4.1 System Settings
There was a time when the configuration of many things in Linux required the modification of text files, or the addition 
of options such as command-line flags at runtime. But there’s been much progress since then, and desktop environ-
ments provide a consolidated, “Control Panel”-style application.

KDE has “System Settings,” which has a UI similar to the “System Preferences” of Mac OS X. Each of the “configura-
tion modules” is arranged into groupings.

Clicking on each of the icons on the main screen will take you to a configuration module, each of which may have 
one or more tabs full of options. While we can’t list each and every configuration module here (the KDE UserBase 
Wiki does a good job of this), and many of them are self-explanatory (such as changing your password in the “Account 
Details” module), the below sections will outline two useful ones.

4.1.1 Shortcuts & Gestures
Go to the “Shortcuts and Gestures” module in the “Common Appearance and Behavior” group. KDE uses a detailed 
system for keyboard shortcuts that includes the following modules:

•	 Standard Keyboard Shortcuts: This screen lets set or modify the shortcuts for commands com-
mon across many applications (such as “Save,” “New,” “Print,” etc.). Most of these use the “Con-
trol” key by default. But you can change this, or set secondary (called “Alternate” shortcut) using 
the process described below. These shortcuts will work on the current (active) application.

•	 Global Keyboard Shortcuts: These are shortcuts that will work regardless of which application 
you’re currently in, and are commonly used to do things that aren’t program-specific (like chang-
ing the volume or switching to Activities).

•	 Custom Shortcuts: You can set up shortcuts for just about any program, including setting up 
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gestures for them. This section requires a little more understanding of KDE and its underlying 
framework (such as D-Bus messages) to use completely, but even at its most basic level you 
can use it to set up a “hotkey” for any application on your system.

Let’s set up one of these hotkeys, as it will demonstrate how to assign these key combinations in the process. Click 
on the “Custom Shortcuts,” then click on the “Edit” button at the bottom of the list of current shortcuts. One of these 
options is “New Group,” which allows you to collect these into folders to organize them. After you give the new Group 
a name, click on the “Edit” button again, then “New > Global Shortcut > Command/URL,” using “Launch File Manager” 
for its name.

There main portion of the dialog has three main tabs:

•	 Comment: This is an area for you to enter some notes regarding the shortcut... what it’s for, etc.

•	 Trigger: This is the key combination you want for the shortcut.

•	 Action: This is what will happen when you enter the above combination, which in this case is to 
execute a command.
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In order to set up this shortcut, enter the following in each section:

•	 Comment: Here, enter, “This shortcut will open the default file manager.”

•	 Trigger: There is a button here labeled “None,” since the key combination hasn’t been assigned 
yet. Clicking on this will change that label to “Input ...,” indicating that the next key combination 
you enter will be captured and assigned. If you hold down the “Windows” key (if you have one), 
then press the “p” key, the combination will be recorded as “Meta+P.”

•	 Action: In the field labeled “Command/URL,” enter “dolphin,” the name of the KDE file manager 
(more on this application in a bit).

After clicking the “Apply” button in the lower-right corner of the window, anytime you want to launch the file manager, 
rather than searching for a launcher icon you’ll just need to hit the “Windows-P” key combination.

4.1.2 Application Appearance/Workspace Appearance (Theme)
One area where the customizability of KDE currently gets in its own way is when it comes to setting the visual aspects 
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of your environment, i.e. theming. Windows (at least the last time the author used it) had a mechanism where a theme 
could be downloaded and installed, and it would set the necessary configurations for all aspects of the system: fonts, 
background, appearance of window title bars, etc.

As it stands in KDE, these configurations are spread across three separate items in System Settings:

•	 Application Appearance: How the bits and pieces that make up applications look, such as but-
tons and menus, is set in this module. It includes tabs to configure Style (specifically, for controls 
like buttons, sliders, and tabs), Colors (colors for just about everywhere a background or text 
appears in the system), Icons (the graphics used for buttons, files/documents and their types, 
e.g. how the icon for “Word files” looks), Fonts (what typeface is used for elements, and at what 
size), Gtk (which attempts to create settings that make non-KDE applications using the Gtk tool-
kit look similar to native KDE programs), and Emoticons (which defines what text that the system 
should interpret as emoticons, and which graphics to show in its place).

•	 Workspace Appearance: While the above module controls how things look within a particular 
application, this one defines how things look across the environment. It has a number of tabs, 
including Window Decorations (which define how the title bars of applications look, and where 
the buttons such “Close” are located), Cursor Theme (the shape and behavior of the cursor), 
Desktop Theme (which will set a number of other configurations, including Color Scheme and 
Icon Theme), and Splash Screen (the progress dialog that showed when you first logged into 
KDE).
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Unfortunately, while you can download new Desktop Themes from within System Settings (using the “Get New 
Themes” button on the “Desktop Theme” tab) or from sites such as KDE Look, the themes still don’t set every aspect 
of the appearance like you’d expect. In order to truly get the look you’re seeking, you’ll probably need to visit each of 
the tabs in the two above modules and make some changes.

4.2 Dolphin File Manager
During the course of doing computer work, you’re likely to be moving files and folders all around our own machines, as 
well as transferring them to other machines or devices. The file manager is the application for this. Windows has the 
venerable Explorer, while Mac users rely on Finder. Linux has many, many file managers, but Dolphin is the default file 
manager for KDE.

Dolphin (available under System in the “K” Menu) is unassuming when you first open it, showing the folders and files 
for your home directory. The left-hand side of the window shows a number of locations, including “Home” (your home 
directory), “Network” (shortcuts to network locations, such as FTP sites), “Root” (the root of your machine’s filesys-
tem), and “Trash” (your trash bin). These locations are in the “Places Panel” (press F9 to toggle it on or off, or select it 
from the “View > Panels” menu), not to be confused with desktop Panels. You can add locations to the “Places” panel 
by right-clicking a folder, and selecting “Add to Places.” In addition to Places, Dolphin can display up to three other 
Panels:

•	 Folders Panel (F7 to toggle on/off): Displays a tree view of the currently viewed folder relative to 
folders above and below it.

•	 Information Panel (F11 to toggle on/off): Displays details of the currently selected file, such as 
size, owner, and modified date.

•	 Terminal Panel (F4 to toggle on/off): Displays a terminal at the bottom of the Dolphin window 
with the currently viewed folder as the working directory (useful for issuing quick terminal com-
mands on the files you’re currently reviewing).
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The top row of buttons provides options for display of the file list (Icon View, Compact View showing only names, or 
Details view showing name and other information), whether Dolphin should load previews of files, and the ability to 
split the window. Other options are in the menu as well as under the “Control” button.

One way to utilize Dolphin is to open multiple windows and drag-and-drop files between them. But you can also utilize 
the “split” feature to move or copy files within the same window. The effect is the same, when you drop the folders/files 
at their destination, a pop-up will prompt you to select whether you’d like to move the files, copy them, or link them.

But Dolphin is much more than moving files around your local machine. Through the magic of kioslaves, you can set 
it up so that many different types of locations look like they’re local to your machine. This lets you do neat things like 
edit a file on a remote FTP server without having to download it, open it, edit, save it, and re-upload it to the place you 
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got it. Instead, just click in the location bar of the Dolphin window, and enter the address where the file is (such as ftp://
ftp.mysite.com). The FTP kioslave will handle the connection to the FTP site, as well as any necessary uploads/down-
loads of the file.

Network connections are especially easy using the “Add Network Folder” wizard. Click the “Network” item in the 
Places Panel, and the last entry will be “Add Network Folder.” The two screens that follow will collect the necessary 
information to connect to the network resource, then set up a shortcut so you can easily get to it in the future.
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Once you set these items up, Dolphin becomes your hub for moving your content to all sorts of places: web files to 
your server, pictures from your digital camera to your computer (via the “PTP” kioslave), or music to your Android 
phone (via the “MTP” kioslave).

Note: MakeUseOf has previously compared how Dolphin stacks up against Nautilus, the default file manager for 
Ubuntu.

4.3 Muon Package Manager
While KDE does come with an impressive amount of software out of the box, at some point you’ll want more. The 
Muon Software Center or Muon Discover application (both available under System in the “K” Menu) are the places to 
look for it. Muon Discover is more of a modern “app store”-style experience, where the Software Center is a no-non-
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sense search-and-install application.

Fortunately, both of them make the process of installing things dead simple. Find the application you want, click “In-
stall,” enter your password. Muon takes care of the rest. Both can also help you manage your software sources (using 
the “Sources” button in the toolbar of Muon Discover, or via the Settings > Configure Software Sources in the Software 
Center). Updates are handled automatically, with Muon Updater appearing in the System Tray as previously shown 
when new versions of installed software are available.

Here’s a great primer on Ubuntu package management, all of which applies to Muon.

4.4 Kate Text Editor
If you use Linux for any length of time, you get used to editing text files. It’s inevitable. So knowing your way around 
the text editor that best fits your needs will make you more productive in the long run. Most programmers swear by 
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“hardcore,” terminal-based editors such as emacs or vim, but this author’s needs are suited perfectly to Kate, KDE’s 
“advanced” text editor.

While we won’t go over all the ins and outs of editing text with Kate here, the following is a short list of why Kate is this 
author’s go-to text editor:

•	 Pre-configured for KDE: There’s no fussing trying to get certain text files to open in another 
editor (particularly one based in terminal). Click (or right-click) on just about any text-based file, 
whether it’s plain text, HTML, or (this author’s favorite) Markdown, and Kate is at least one of the 
applications to open it, if not the default one.

•	 Syntax Highlighting: Kate offers a wide variety of syntax highlighting (you can check the syn-
taxes available under the Tools > Mode and Tools > Highlighting menus), or coloring/decorating 
text a certain way. For example, tags in an HTML file are automatically bolded, where the head-
ings in the Markdown file used to prepare this manuscript are bolded and colored purple for easy 
identification.

•	 Scripting: Specifically, the support to “Build.” This is usually used for software development to 
compile software, but this author uses it to invoke the pandoc command on Markdown to convert 
it to HTML with a keyboard shortcut (assigned to the “Quick Build” feature under Build > Quick 
Build).

•	 Sessions: Lastly, if you have a number of files you’re editing together, you can save them as a 
“Session” (Save Session As under the Sessions menu). Then, next time you go to resume Kate, 
you can open the session, and all your files will open together, leaving you right where you left 
off.

Here’s a quick comparison of Kate and gEdit, the default file manager for Unity and GNOME. Also, if you’d like to see 
why Markdown is so awesome, take a look at this overview of using Markdown in an editor on the Mac.

4.5 Konsole Terminal Emulator
Like a text editor, working at the command line becomes second nature to most Linux users within pretty short order. 
Konsole (available under System in the “K” Menu) is the standard terminal emulator, and has some nice functions 
including the following:
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•	 It supports tabs, meaning one Konsole window can hold a number of active terminal sessions.

•	 It supports sessions, which (like Sessions in Kate) can save your current state so you can pick it 
up again later.

•	 It makes it easy to copy text from, and paste text to, the terminal window (this seems like a 
simple thing, but more important that it might seem).

Aside from these couple of features, Konsole is really as useful as your knowledge of the command line. MakeUseOf 
has covered the command line with articles ranging from essential commands for those just starting out with Linux to a 
useful Linux command cheat sheet for daily use to advanced command line techniques.
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5. Other KDE SC Packages                               
As mentioned, the KDE SC includes a wide variety of applications, some pre-installed, some available for easy instal-
lation via your distributions package manager. We’ll list some of the notable applications in each of KDE’s program 
categories in the sections below.

5.1 Games
KDE developers have brought a large number of classic games to the Software Collection, including the following:

•	 knavalbattle: A clone of the famous game about battling ships.

•	 kreversi: Surround your opponents stones and reverse them to your color.

•	 kbreakout: Deflect the ball to break the obstacles above.

•	 kpatience: A classic time-waster also known as Solitaire.

In addition, you can install non-KDE games in your desktop without issue.

•	 Steam: The release of a native Steam client for Linux, covered by MakeUseOf from its release 
in beta, brings a large number of top-tier games to Linux, including Portal.

•	 TuxRacer: TuxRacer, a game about the Linux mascot speeding down a snowy mountain, is a 
perennial favorite, and available from Muon Software Center as “Extreme Tux Racer.”

5.2 Graphics
While Linux might not have a native version of Adobe Photoshop, it does have plenty of graphics apps.

5.2.1 View Documents (Okular)
You can open many document types, including PDFs and e-books, in Okular just by clicking on them. Okular operates 
like most reader applications, with a page-by-page thumbnail view on the left side, and the full-size pages taking up 
the remainder of the screen.
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5.2.2 Edit Images (Gwenview)
This author finds the Gwenview image viewer to be far and away the most useful application in this category. Not just 
a viewer, there are a couple of keyboard shortcuts that allow for very quick, simple image editing:

•	 Press Shift-R to display a dialog that allows you to scale and resize the image. Hit Alt-R to ac-
cept the resizing.

•	 Press Shift-C to display eight handles you can drag to crop the image. Hit Alt-C to accept the 
cropping.

•	 Press the Left or Right keys to navigate through all the images in the current folder.

Gwenview will be the application selected to open most image formats by default, and the above make it extremely 
efficient to prepare an entire directory of screenshots for publishing, for example.

5.2.3 Paint (Kolourpaint4)
When you need to do some more involved editing, such as adding lines, boxes, or circles to your image, KolourPaint 
is a program reminiscent of Windows Paint that allows you to do image editing. Still nothing as involved as Photoshop, 
but you can add text or shapes in different colors.
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5.2.4 Scan Images (Skanlite)
The skanlite program allows you to retrieve images from your scanner without the terminal commands required in 
days of yore. This application will detect any configured scanners, allow you to grab a preview of the document on the 
bed, and save that scan to your preferred format.

5.3 Internet
The KDE Network group of applications provides everything you need to browse the web, manage your e-mail, instant 
message with friends, download media, and take advantage of all the resources the Internet has to offer. But first, 
you’ll need to configure your network connection.

5.3.1 KNetworkManager
Most users are accustomed to having a tool in their system tray that allows them to jump between networks: their 
home network (protected by WPA), office network (which could be a wired connection), or coffee shop hotspot. KNet-
workManager (which we saw briefly during our introduction to the desktop) allows you do to all these things. Located 
in the System Tray, this Widget will let you know if you’re connected to a network, if so, which one, or what’s available 
if you’re offline.

When you click on the icon in the System Tray, you’ll see a list of active connections, as well as those you’ve config-
ured but are not currently connected. To create a new network connection (for example, to connect to the wireless 
network at your office), click the wrench icon in the lower-right of the pop-up, then click the “Edit Connections” button.

The Connection Editor will display, which contains an “Add Connection” option. You’ll have a range of connections 
to choose from, including wired, wireless, ISP-specific connections such as DSL routers or cable modems, or virtual 
private networks (VPNs).
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To connect to a wireless network, select the “Wireless” option. You’ll be presented with a dialog with the following 
important tabs:

•	 Wireless: This tab will open by default. You can use the fields here to give the connection a 
name (e.g. “Work”) and enter the network name (this goes in the “SSID” field).

•	 Wireless Security: Here you’ll be able to select the security type the network uses (if any), and 
set the key/password to connect.

•	 General: Going back to the first tab, you can set some options such as whether to automatically 
connect to the network when you’re in range, and whether you want other users on your system 
to be able to use it (for example, set this for your home network if you share a machine with 
someone, but do not select it for your work’s connection, so only you can connect to it).
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Once you’ve finished, click “OK” to save the profile (the process is similar for other types of connections, just with 
different tabs to fill in). The new network should appear when you click on the icon in the System Tray again – click 
its name, then the “Connect” button to get hooked up to that network. Now that you’re on the Interwebs, let’s look at 
some of KDE’s programs.

5.3.2 Browsers
Out of the box KDE comes with “Rekonq,” a lightweight browser based on the same framework (WebKit) as Google 
Chrome. As a lightweight browser, it should work well for viewing all but the most whiz-bang sites. Rekonq is also inte-
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grated into all the background KDE systems, so you can store bookmarks using the global KDE bookmark list (there’s 
a convenient Widget for adding these to a Panel or the desktop), and stores its passwords in KWallet (more on this 
application in a bit).

However, many users are accustomed to two of the “big” browsers available on other systems: Firefox and Chrome. 
These both are also available for Linux integrate with KDE to varying extents, as follows:

Firefox: On Kubuntu, you can use the Firefox installer to set up this browser, which will set up the browser for you. 
There are also add-ons to provide KDE icons for Firefox and allow it to store passwords in KWallet, KDE’s password 
manager.

Chrome: Chrome also plays nicely with KDE, with the ability to store passwords in KWallet built-in. There is an exten-
sion in the Chrome Web Store that provides some themes as well.

5.3.3 E-mail
Outlook was always one of this author’s favorite programs in the Windows world, for the way it brought some impor-
tant personal information together in one convenient application. KDE has gone one step beyond this with Kontact. 
While separate applications exist for calender/tasks (KOrganizer), e-mail (KMail), contacts (KAddressbook), and notes 
(KNotes, KJots, or the BasKet note manager), Kontact combines them all in one “shell,” with easy access to switch 
between them.
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To get your e-mail set up, click on the “Mail” button on the left-hand side, and select the “Tools > Account Wizard” 
menu item. You can enter your name, e-mail address, and password, and Kontact will attempt to configure your e-mail 
account for you. If you use a popular provider like GMail, this should go off without a hitch.

You can also add other Internet-connected accounts to Kontact. For Calendar & Tasks: Kontact can sync up appoint-
ments and to-do’s with Google. Click on the “Calendar” button on the left-hand side, right-click in the lower panel on 
the left-hand side, then right-click and select “Add Calendar.”

A list of potential calendar sources will display... scroll down the list and select “Google Calendar and Tasks.”
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Once you enter your username and password, your Google Calendar items will show up within Kontact. You can view 
both appointments and tasks in the “Calendar” view, or switch to the “To-do List” view to focus on your work.

You can do the same for your address book by clicking the “Contacts” button, then “Add Address Book.”
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A similar list will appear, from which you can choose “Google Contacts.”

Kontact has a few other useful components as well:

•	 The “Summary” screen shows you your day at a glance, including upcoming appointments and 
events, to-dos, unread e-mails, and if you have any notes created.

•	 The “Feeds” screen allows you to read RSS feeds. If you’re in the market for a news reader, 
since Google Reader shut down, Feeds (which is the program Akregator within the Kontact 
shell) is a fine replacement.

•	 The “Usenet” screen is similar to Feeds, but for older-style Usenet groups.

•	 The “Journal” allows you to create entries that are associated with one of your calendars. You 
can enter a date and time, and provide a description of what you did. This makes it useful for 
simple time tracking.

•	 “Notebooks” are akin to Evernote or OneNote, only a little simpler. You have the ability to create 
notebooks, and then enter pages within those notebooks.

•	 In contrast, “Popup Notes” are just like the “post-it”-style notes that serves as their icon. These 
are for smaller bits of text, and are arranged in a grid (as opposed to the tree view in Note-
books), just like they would be if they were spread all over your desk.

Kontact is a solid replacement if you liked Outlook on Windows, and while it may not have quite the degree of integra-
tion between its parts (you can’t convert an e-mail into a meeting, for example), it includes some other features within 
it that make it useful for managing all your personal information.

5.3.4 Instant Messaging
Instant messaging has gone through something of an overhaul in Linux, with the Telepathy framework being used to 
provide access to multiple IM providers such as AIM, Yahoo, ICQ and others. KDE has integrated Telepathy into the 
desktop, meaning (if you choose to use it) there is no “instant messenger” client anymore.

This is a little hard to grasp at first, but when you consider that if you’ve been using a program like Trillian or eBuddy, 
you’ve been receiving all your IMs in one place anyway. This just puts them out of the way, without a different program 
that you need to open.

To get yourself started, open System Settings, and under the “Network and Connectivity” group, select the “Instant 
Messaging and VOIP” module. You’ll be presented with a screen where you can begin adding all your IM accounts. 
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Click the “Add Account” button, select one of the supported providers, and enter your username and password.

Once your account is set up, you’ll want to place an Instant Messaging Presence Widget on your Panel or desktop 
(the Panel is probably best, so it’s not covered over with other windows). Then, you can get connected to any ac-
counts you’ve set up by right-clicking on the Widget and setting your status to “Online.”

You can select some options in the “General” tab of the Instant Messaging and VOIP settings module, such as wheth-
er all chats should be displayed in one, tabbed window, whether notifications should appear (and if so, if they should 
be accompanied by sound), and if your status should automatically set to “Away” after a set time.
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5.3.5 Other Network Programs
There are a number of other useful programs in the KDE Network category, such as:

•	 KTorrent: This is a BitTorrent client. When you open a .torrent file, KTorrent will offer to down-
load it for you. You can pause and resume large downloads, and do the right thing by offering 
the file for download by other users.

•	 KRDC: KRDC is a remote desktop client that supports the VNC and RDP protocols. Once you 
make a connection, you can save the settings as a “bookmark” so you can log into the machine 
with one click in the future.

•	 On the flip side, Krfb can help you set up your machine so you can remote into it from other 
devices. You’re able to set up a password to keep prying eyes out of your computer, or set it up 
so those who connect can only see the screen, but not control it.

•	 BlueDevil: If you have Bluetooth devices you’d like to connect to your machine, BlueDevil will 
help you get them paired up and configured.

5.4 Multimedia
Multimedia isn’t nearly the problem it once was on Linux, with most formats playing out of the box or with the quick 
installation of some codecs, like those in the “ubuntu-restricted-extras” package. If you have an extensive media 
collection, you’ll be able to enjoy it using two KDE applications: Amarok for music, and Dragon Player for video. An ad-
ditional program, K3b, will allow you to rip and burn optical disks.

5.4.1 Amarok
While some of the default applications in KDE are a balance of simplicity and power, Amarok is packed with features. 
Your first step when using Amarok should be to point it at your music collection, at which point it will begin reading the 
MP3 tags. Select “Settings > Configure Amarok” from the menu, then click on the “Local Collection” button on the left-
hand side organized them by artist and album. This displays a tree view of all the folders on your system. To include a 
folder (and the files it contains), just check the box next to the folder’s name.
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Once you’re finished, Amarok will begin scanning your collection, which will appear in the left-hand side of the main 
window. The large area in the center shows an equalizer, and when a song plays it will display lyrics if they are avail-
able. You can create playlists by dragging files (or the entire collection) over to the panel on the right, order them to 
taste, and save them (this is called adding a “Bookmark” for the playlist in Amarok).
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Read more about Amarok’s many features, if you’re curious.

5.4.2 Dragon Player
Compared to Amarok, Dragon Player is simple. The main interface leaves little to question: there are buttons to “Play 
Media” (a file on your machine), “Play Disc” (removable media in your machine’s drive, such as a DVD), or “Play 
Stream” (you’ll need to provide a URL to the video you’d like to play).

This is a program you might not open directly very often, but rather use by opening one of the file types it supports 
(such as FLV, MPEGs 1, 2, and 4, or AVI). It’s not flashy, but it does its job well, and it’s lightweight to boot.

5.4.3 K3b
If you’re one of the luddites who still purchases music on CD, the K3b application will allow you to rip that music to for-
mats such as OGG or MP3. Located in the “Multimedia” section of the “K” Menu, you can open it and select the “Rip 
Audio” option from the Tools menu (or “Rip Video” or “Rip DVD” for those types, although you’ll need some additional 
packages to back up your DVDs).
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The dialog that follows allows you to configure how you’d like the filenames to be created, and the format to which 
you’d like to files converted.

To burn a CD, you can use the “Tools > Burn Image” option if you have an ISO file (say, a download of the latest 
Kubuntu version). Or, if you’re making an old-school “mix tape,” you can use the “New Audio Project” button at the bot-
tom of the screen.

This will allow you to drag files from the list at the top of the screen, re-arrange them, and burn the result.

Read this comparison of K3b to the GNOME burning program Brasero for more information.

5.5 Office
The KDE project doesn’t have its own office suite, at least not part of the official project (Calligra, which well mention 
a little later, is a fork of the previous KOffice code). But both LibreOffice (the default on Ubuntu) and OpenOffice offer 
packages that help integrate them into the desktop:

•	 The “libreoffice-kde” and “libreoffice-style-oxygen” packages will configure the programs to dis-
play KDE-style icons, and use the KDE file selector dialog (meaning you have access to all the 
Places you set up in Dolphin).

•	 The “kde-thumbnailer-openoffice” package will allow KDE applications and dialogs to display 
thumbnail previews of the OpenDocument-format files created by these programs.
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Two other members of the KDE Office category installed by default are:

•	 Kontact: We covered this in the “Internet” section (and the KMail application that is part of it is 
available in the “Internet” section of the “K” Menu), but the menu item for Kontact is included in 
the “Office” group. Like KMail, Kontact’s calendar (KOrganizer) and contact manager (KAddress-
Book) components are also available as separate applications in the Office menu.

•	 KTimeTracker: This is a little application for tracking your time spent on various tasks.

Of course, the business-related tools you use in other desktops will be fully usable in KDE as well.

5.6 System Tools
We’ve covered some of the big applications in the “System Tools” group earlier in the guide: Dolphin, the Muon Suite, 
and Konsole. But there are two other programs in this category worth mentioning.

5.6.1 Additional Drivers
The “Additional Drivers” program can help you determine whether there is a closed-source, proprietary driver for hard-
ware on your system. By default, most Linux distributions (at least those based on Ubuntu) won’t install these. While 
this is a philosophical choice, the fact remains that unless manufacturers themselves release them as open source, 
even their proprietary drivers usually have advantages in features or performance compared to those produced by the 
community.
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When you start up this program, it will scan your system to see if there’s hardware it can match up to a proprietary 
driver. If so, it will display some details about the driver, and give you the option to install. In contrast to getting the 
driver directly from the manufacturer, this is as easy as clicking the button. The app will install and configure the driver 
for you (although you may need to restart in order to see the benefits).

5.6.2 Startup Disk Creator
Like backups, having a “start-up disk” or “boot disk” is a good idea, in the event something happens that prevents you 
from starting your machine normally. This utility will let you set up a USB drive to act as such as disk.

When you open this program, it will search for a CD from which to create the start-up disk. This can be a physical 
CD in a drive, or a disc image (.ISO), like the one you used to try or install your KDE system. Select this source from 
among the options at the top of the screen (you can click “Other” to select an image file), then select the USB drive 
you’d like to use in the lower area.

You can also set up the USB drive to be “persistent,” meaning your documents and settings will be preserved when 
you shut down after having booted from the start-up disk—if you don’t enable this, anything you do when running from 
the start-up disk will be lost when you’re finished. You can use this feature to create a “portable system” of sorts, in 
that you can plug it into most modern computers, set it to boot from USB, and use your Linux system anywhere.

The radio buttons at the very bottom allow you to select one of these options, and if you want a persistent drive, con-
figure how much space on the drive you want to set aside for storage. Then, just click the “Make Startup Disk” button, 
and the program handles the rest.
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5.7 Utilities
Like most systems, KDE comes with some simple utilities that make your life easier. We’ve covered one of these 
already (Kate), but this category contains the following useful applets:

5.7.1 Ark
This is the KDE archive manager. It allows you to “unzip” a number of compression formats, including the .ZIP files 
you’ll commonly find on other systems. When you open a supported file (their icons will show as “zipped” boxes), 
they’ll open in Ark; click the “Extract” button for some options on where to place the contents. You can also create new 
archives by clicking the “New” button, giving the archive a name (you can automatically set the compression format by 
using the appropriate extension for the file, e.g. “.zip” for WinZip-format files, or “.tar.gz” for the gzipped tar archives 
common on Linux systems), and dragging files or folders into the Ark window.

Note: MakeUseOf has previously compared Ark to the GNOME archive manager File Roller if you want to learn more.

Other members of this category include:

•	 KCalc, a calculator

•	 KNotes, the pop-up notes we saw as part of Kontact

•	 KWrite, a simple “notepad”-style text editor (a little more pared down than Kate)

•	 KCharSelect, for those times when you need to insert a foreign character but can’t remember 
the keycode
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6. Additional Packages and Applications          
Finally, there are applications that, while not part of the KDE project per se, are built on the KDE framework and/or fit 
nicely within the KDE desktop. You can find all sorts of these programs at KDE-Apps.org, but a few that are particu-
larly worthy of mention are as follows:

Calligra: The aforementioned Calligra, like Libre/OpenOffice, contains applications for word processing (Words), 
spreadsheets (Sheets), presentations (Stage), database management (Kexi), and diagrams (Flow). But Calligra also 
provides a project management application (Plan), a vector drawing program (Karbon), and a tool for creating and 
publishing e-books (Author). It tends to be lighter-running than Libre/OpenOffice, but not as feature-rich. You can take 
a look at this MakeUseOf comparison of the Calligra and LibreOffice suites to see which suits you best. Look for “cal-
ligra” in your distribution’s package manager and give it a try, or visit the Calligra website.

Yakuake: Yakuake is a clever application that provides a pop-up terminal that you link to a keyboard shortcut (it’s 
modeled after the drop-down terminal from the game Quake, hence the name). The more you become accustomed 
to using the command line, the more useful it is to have a terminal just a keypress away. Search for “yakuake” in your 
package manager to install.

Scribus: While some of the office programs covered above can assist with simple document layout, Scribus is a 
full-featured desktop publishing program comparable to Adobe Framemaker. It can handle very complex layouts, and 
produce print-quality PDFs. The Scribus website has lots of information, including tutorials.

KDevelop: The KDevelop integrated development environment (IDE) was initially created to assist in the development 
of KDE programs, but has since added for support for a number of programming languages (including web). If you’re 
a programmer who doesn’t insist on using emacs or vim, KDevelop is an option that will fit in nicely with your KDE 
desktop. Check your distribution’s package manager for KDevelop.

Kopete: Before the integration of the Telepathy framework for instant messaging, Kopete was (still is) one of the best 
multi-protocol instant messengers around. It can handle just about every IM network out there, including AIM, Ya-
hoo, MSN, GTalk/Jabber, ICQ, and even Skype and Groupwise. If you’re a Pidgin user, you can find a comparison of 
Kopete and Pidgin on MakeUseOf.
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7. Conclusion                                                    
Thank you for taking the time to learn a little more about the KDE desktop environment, and all the great fea-
tures and applications it provides. Some people argue that having multiple desktop environments simply brings 
fragmentation to Linux. But this choice is one of the things that makes the free software community so great. If 
you don’t like one piece of software, just go out and find another.

The KDE project continues to move forward, with a new 4.12 version of the Software Collection due to be 
released in the near future (at the time of this writing). And the new version 5.0 of the environment promises to 
bring more new and exciting changes, not just on the desktop, but for mobile as well. So go grab a live USB of a 
KDE distro, or fire up your package manager or terminal and install it for yourself. All it will cost you is a little hard 
drive space.

Guide Published: December 2013
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